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Exercise 4: Digitizing New Data 

In this exercise, you will learn the process of creating and editing spatial 
datasets using on-screen, or heads up, digitizing. This is one of the many 
methods of data creation used in GIS. We will also introduce you to 
techniques for searching for background images and other data on the web 
and also how to connect to a GIS server.   

 

Topics covered in this exercise include: 

1. Create a new shapefile in ArcCatalog 
2. Add fields to a new shapefile 
3. Edit spatial data using the editing function in ArcGIS Pro 
4. Digitize within Google Earth Pro 
5. Convert KML data to a shapefile 
6. Connect to a GIS server 
7. Search for geospatial data on the web 

 

Step 1. Preparing to Draw 

In contrast to the previous exercises, you will not be provided with a map 
project file. Instead, you will create a new project from scratch. This is a 
common first step when starting a new study and GIS project. You can use 
this method to create your own projects using your own data.  

� Open ArcGIS Pro. This can be done by navigating to All Apps followed 
by the ArcGIS Folder. Within the ArcGIS folder, select ArcGIS Pro. 
Note that you can also use a Task Bar or Desktop shortcut if they are 
available on your machine.  

� Once ArcGIS Pro launches, select Blank 
under Create a new project on the right side 
of the page.  

� In the Create a New Project Dialog Box, 
name your new project Exercise_4 and 
save it to your personal Exercise_4 folder. 
You can leave “Create a new folder for this 
project” option selected.  

� Click OK to create the new project.  
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Create a new map.  

� Under the Inset Tab select New Map. This will load a new map called 
Map with a topographic base map.  

� Now, rename the map. Double-click on Map in the Contents 
Pane. This will open the Map Properties Window. In this 
window, change the name under the General Tab to 
National Mall. 

� Click OK to accept the change.  

 

You will now add a reference image to the map. This reference image is from 
the National Agriculture Imagery Program (NAIP) and was collected in 2016.  

� Download the Exercise_4 data from https://www.wvview.org/. All lab 
materials are available on the course webpage and linked to the 
exercise. You will need to extract the compressed files and save it to 
the location of your choosing.  

� In ArcGIS Pro - Click on the Add Data Button. Navigate to your copy of 
the lab data. Navigate to Exercise_4 folder. Select the nat_mall.img 
file. Click OK to add it to the map.  

� You can turn off the Topographic base map if you’d like. You don’t 
need it.  

https://www.wvview.org/


3 
 

 

In this exercise we will have you create a new shapefile and digitize new 
features into the file. Note that you could also use a feature class within a 
geodatabase. However, this will be demonstrated in a later lab. So, here we 
will have you work with a shapefile, which is a standalone file used to store 
vector data outside of a geodatabase. There are different ways to create a 
new shapefile. Here, we will use the Create Feature Class tool, which can 
be used to make shapefiles and feature classes.   

� In the Analysis Tab select the Tools icon. This will launch the 
Geoprocessing Pane.  

� Search for the Create Feature Class tool.  
� In the tool, name the new layer nat_mall_draw.shp, save it 

to a folder of your choosing, define the Geometry Type as “Polygon” 
and set the Coordinate System to “Current Map”. Run the tool to 
create the new file. The new file should add to the list of layers in the 
Content Pane. 

In this exercise, we will have you digitize the extent of buildings near the 
National Mall in Washington, DC. However, there are still a few more steps 
before you can begin. First, we would like you to store the name of the 
building in the attribute table. So, you need to add a field.  

� Right-click on the nat_mall_draw layer in the Contents Pane 
then select Attribute Table. The attribute table should load. 
Note that “FID,” “Shape,” and “Id” fields are already included 
in the table. You would like to add a new field called “name.” 
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� Click the Add button at the top of the table.  
� A new table should load called Fields: nat_mall_draw. At the bottom of 

the list of fields, you can add new fields. In the Field Name column 
type “name” (without the quotes) and set the Data Type to Text 
(this is because you will type a text string in this field). You do 
not need to specify an Alias. Click Save at the top of the screen 
to create the field.  

 

� Return to the nat_mall_draw attribute table. You should now see the 
new “name” column.  

� To free up space, exit out of the tables.  

Here, you will draw polygon features. I have generally found that these are 
easier to draw if they are symbolized using no fill and only an outline. So, we 
will have you change the symbology of the layer.  

� Right-click on the nat_mall_draw layer and select Symbology. 
� Click on the symbol in the Symbology Pane.  
� Switch to Properties as opposed to Gallery. 
� Change the Color to No Color. 
� Change the Outline Color to something easy to see, like red. You may 

also want to increase the Outline width. We chose to use 1 pt.  
� Click Apply to accept the changes.  

 

� You may want to exit out of the Symbology Pane to save space.  
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Step 2. Drawing 

You are now ready to start drawing and editing the attribute table.  

� Navigate to the Edit Tab. 
� Turn on the Attribute Pane by clicking on this option. 

We will begin by drawing in the Capital Building.  

� Zoom in so that the Capital Buildings fills a large portion of the map 
space. The larger the object of interest is on the screen, the easier it 
will be to trace it.  

 

� Click on the Create button. This will load the Create Features 
Pane. You are now ready to start drawing. Click on the layer 
in the Create Features Pane in which you want to draw a new 
feature. In this case, you only have the one layer available, 
nat_mall_draw; however, if more vector layers were included in the 
layout then you would need to choose which to draw into. Click on 
nat_mall_draw to draw into it. You are now ready to draw. 

� Since this is a building, and we would expect to have right angles on 
each corner, I would suggest using the right-angle drawing tool. Feel 
free to experiment with the different drawing tools. 
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If you hover over the different drawing tools, a brief explanation will be 
provided. I chose to use the third option, so that right angles are enforced.  

� Once you’ve selected a drawing tool, move to the map space and click 
once at the location on the map where you want to add a vertex. 
Continue clicking to add additional vertices. Work your way around the 
object, just like you were walking the perimeter. When you get to the 
last vertex, double-click. This will close the feature and create a new 
polygon object. Note that your drawing doesn’t have to be perfect.  

Note: If you would like to erase your last vertex, use CTRL+Z. Once you’ve 
completed an object and it is still selected, you can remove or delete the 
object by using CTRL+Z.  

Here is an example of my result.  
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There are many tools available to clean up or improve your drawing. I would 
encourage you to experiment with the tools available in the tools list. 
Hovering over a tool will provide a brief explanation.  

 

If you are not happy with the quality of your drawing, you can always delete 
it and try again. Note that there are tools available to move the whole 
feature, add vertices, remove vertices, edit vertices, reshape features, split 
single features into multiple features, merge multiple features into a single 
feature, modify features, and delete features.  

The Snapping options allow you to enforce snapping. For example, if you 
were drawing line features and you wanted them to connect, such as rivers 
or roads, you could use snapping to enforce this.  

When you are drawing, it is also important that you save often so as not to 
lose your work. Let’s save your work. 

� Click the Save button under the Manage Edits area in the Edit Tab.  

Again, save often so as not to lose any work. 

Now, we would like you to name the building in 
the attribute table.  

� Navigate to the Attributes Tab. Since you 
were just using the Create Features Pane, 
the Attribute Pane is now probably behind 
it, but there should be a tab at the bottom 
of the screen. If you can’t find it, click on 
the Attributes button again in the Selection 
area of the Edit Tab. 

� Make sure that the capital building polygon 
is selected.  

� In the Attributes Tab, type in “Capital 
Building” (without the quotes) in the 
“name” field.  

� Save your work again.  

You have now successfully created a new 
polygon and edited the associated attributes. 



8 
 

Deliverable 1 (30 Points) 

Draw polygons for the following buildings:  

Capital Building, National Gallery East, National Gallery West, American 
Indian Museum, Air and Space Museum, Hirshhorn Museum, Natural History 
Museum, and American History Museum 

You can use the image below to locate these buildings. This image has also 
been provided in the lab data folder. 

 

Image from Smithsonian Associates: 
https://smithsonianassociates.org/ticketing/ 

Provide the name of each building in the attribute column “name” field. 
Again, remember to save your edits and project often. These are two 
separate processes. 

Note: Throughout this process, you will need to switch between drawing and 
navigating the map space. The navigation tools are available under the Map 
Tab while the drawing tools are available under the Edit Tab. You will need 
to switch back and forth. If you need to select a feature, the Selection Tool 
is available in the Map Tab and in the Editing Tab. Remember that the 
attributes displayed in the Attribute Pane are for the selected feature. If you 
want to view the layer attribute table at any time, you can do so by opening 
the attribute table. This is a good way to check your edits.  

Drawing in ArcGIS Pro, especially for a beginner, can be frustrating. Take 
your time and don’t hesitate to ask if you have any questions.  

 

 

https://smithsonianassociates.org/ticketing/


9 
 

Make a map layout that includes the following: 

1. All of your buildings are displayed using a different color (4 points) 
2. The names of the buildings are in the legend (4 points) 
3. The image data are not included in the legend (2 points) 
4. A scale bar in miles (3 points) 
5. A north arrow. The north arrow should not be large or take up a lot 

of space on the layout (3 points) 
6. A descriptive title (3 points) 
7. Your name (2 points) 
8. In landscape orientation (3 points) 
9. The map is overall very neat and well organized. Spaced is utilized 

well, and the data are well presented (6 Points) 

Provide an output of your map as a PDF and turn it in as part of the 
lab submission.  

Here are some hints. 

1. You will need to add a new layout to the project.  
2. To symbolize the buildings using a different color for each building, 

you will need to use a Unique Values method and the “name” field. 
3. Referring back to the last lab may help with map design. 
4. Don’t hesitate to ask if you have any questions.  

 

Step 3. Drawing in Google Earth 

Drawing new features can be accomplished in different software tools. For 
example, Open Street Map (https://www.openstreetmap.org) is an open 
source, web-based tool to create new data. Here, we will experiment with 
drawing in Google Earth. We will then convert the Google Earth data to a 
layer for use in ArcGIS Pro. You will specifically work with Google Earth Pro, 
which is currently free and can be obtained here:  
https://www.google.com/earth/desktop/. 

In this second exercise, you will draw three of the finger lakes of New York. 

� Open Google Earth Pro. This can be done by navigating to All Apps 
followed by Google Earth Pro. Note that you can also use a Task Bar or 
Desktop shortcut if they are available on your machine.  

� Once the program launches, navigate to the Finger Lakes Region of 
New York. If you’re not sure where this region is you can search for it 
using the search bar. 

https://www.openstreetmap.org/
https://www.google.com/earth/desktop/
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You will digitize three of the Finger Lakes: Seneca, Cayuga, and Owasco.  

 

Here are the required steps to digitize in Google Earth Pro. 

� First, you will want to create a new folder under My Places. Right-click 
on My Places then select Add followed by Folder. Name the folder 
Lakes. 

� Click on the Lakes folder under Places. Select Add then Polygon.  
� Find Seneca Lake. 
� Digitize the boundary of the lake using the polygon tool 
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Note: You do not need to spend a lot of time digitizing these features. A 
rough polygon is fine.  

Note: It might be easier to digitize if you make the feature hollow. Do this 
by selecting Style, Color in the New Polygon window. Change the Area to 
Outlined as opposed to Filled+Outlined. 

� Once you’ve digitized Seneca Lake, edit the name to “Seneca” in the 
Name field of the New Polygon window.  

� Click OK to save the feature.  
� Repeat this process to digitize Cayuga and Owasco lakes. Make sure to 

save the features in the same folder but as separate polygons. 

Now that you have features, you will save them to KML/KMZ format. KML 
stands for Keyhole Markup Language, and a KMZ file is a compressed 
version of a KML file.  

� Right-click on the Lakes folder under Places. Select Save Places As. 
Set the type to KML and save the file to your personal folder.  

You are now done working in Google Earth Pro. You will now return to 
ArcGIS Pro to complete this portion of the lab.  
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Back in ArcGIS Pro, you will need to create a new map. Since this is a 
different geographic area, we do not want to use the National Mall map.  

� Insert a new map and name it Finger Lakes. 
 
You will now convert the KML file created in Google Earth Pro to a vector file 
that can be read and viewed in ArcGIS Pro.  
 

� Open the Geoprocessing Pane by clicking on the Tools icon in the 
Analysis Tab.   

� In the Geoprocessing Pane, select Toolboxes. This will open the 
ArcToolbox directory. 

� Navigate to Conversion Tools followed by KML.  
� Click on KML To Layer.  
� Set the Input KML File to the KML file created above.  
� Set the Output Location to your Exercise_4 folder. 
� Name the output lakes. 
� Do not select Include Ground Overlay. 
� Click Run to execute the tool.  

 

 

This should add the lakes to your layout.  

Now, we will show you how to change the base map. By default, the 
Topographic base map is used. Here, we will have you change the base map 
to an image base map.  

� Navigate to the Map Tab. Click on the dropdown arrow on the 
Basemap icon. This will load a list of available base maps.   

� Change the base map to the Imagery base map.  
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Note: Base maps can be slow to 
load, depending on your computer 
and internet connection. So, it is 
important to remember to save 
your work often if you are using 
base maps.  
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Deliverable 2 (30 Points) 

Make a map layout to include the following: 

1. All three lakes are displayed with a border and are hollow (3 points) 
2. The names of the lakes are in the legend with a different border 

color symbolized for each lake (3 points) 
3. The image data are not included in the legend (2 points) 
4. A scale bar in miles (3 points) 
5. A north arrow. The north arrow should not be large or take up a lot 

of space on the layout (3 points) 
6. A descriptive title (3 points) 
7. Your name (2 points) 
8. In portrait orientation (3 points) 
9. A reference is provided for your base map (should read: “Base 

imagery from ArcGIS base map data.”) (4 points) 
10. The map is overall very neat and well organized. Spaced is utilized 

well, and the data are well presented (4 Points) 

Here are some hints. 

1. You will need to add a new layout to the project.  
2. To symbolize the lakes using a different color for each lake, you will 

need to use a Unique Values method and the “Name” field. You will 
need to expand the lakes layer in the Contents Pane and make 
these changes on the Polygons sublayer.  

3. Referring back to the last lab may help with map design. 
4. Don’t hesitate to ask if you have any questions.  

This lab will be graded out of 60 points. Make sure to deliver both 
maps to your instructor as PDF files. 

This is the end of the required portion of the lab. The rest of the lab provides 
some examples of how to find imagery on the web and how to connect to a 
GIS server to stream data into your map. This section is not required and 
does not include any deliverables or questions. However, we would suggest 
working through this section of the lab, as we have found these skills to be 
useful. 

Extra: Step 4. Finding NAIP Orthophotography and Other Data 

The image used in National Mall portion of the lab is from the National 
Agriculture Imagery Program (NAIP). These data are currently free and offer 
nearly cloud free coverage of large extents. Additionally, the data are 
orthorectified, or orthophotography, in which scale distortions due to vertical 
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relief displacement have been removed. So, they are a good data source of 
reference data for digitizing. These data can be obtained from many sources. 
For example, in West Virginia, you can download data for the state from the 
WV GIS Technical Center. Here is a link to the 2016 data: 
http://wvgis.wvu.edu/data/dataset.php?ID=469. Other than imagery, if you 
are looking for GIS data for West Virginia, the WV GIS Tech Center is a good 
place to start your search. 

Here we will demonstrate how these data can be obtained from the NRCS 
Geospatial Data Gateway: https://datagateway.nrcs.usda.gov/. Note that 
data can be downloaded from this website free of charge. You will have to 
provide some information before you can download the data. However, this 
is safe. Once your request is available, you will receive an e-mail. You can 
then download the data. For this lab, you will not need to download the 
data. This is simply a demonstration. 

� Go to the website: https://datagateway.nrcs.usda.gov/. 
 

 
 

� Select the NAIP Download option on the right side of the page. 

From this page, you can download county level orthoimage mosaics of the 
NAIP data.  

http://wvgis.wvu.edu/data/dataset.php?ID=469
https://datagateway.nrcs.usda.gov/
https://datagateway.nrcs.usda.gov/
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� Return to the previous page.  

You can download other data from this website. Before we leave the page, 
let’s investigate what other data are available.  

� Select the Order by Interactive Map using custom Area of Interest 
option. 

A map should open. Navigate to an area that is of interest to you in the 
United States. My example below is for Pittsburgh, Pennsylvania. 
 

 

� Once you have found your area of interest, click the Select Area 
option.  
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� Draw a rectangle for your area of interest. Here, I am showing 
downtown Pittsburgh. 

 

� Next, select Accept Area. 

A page should load showing the datasets available for this area. Data 
available include TIGER Census data, climate data, digital elevation data, 
geologic data, surface hydrology, and soil. So this is a good source of 
geospatial data, especially if you are interested in natural or environmental 
data. 
 
These are just a few examples of sites that provide GIS data. There are 
many others. Feel free to ask if you are curious as to the best websites to 
find specific types of data. 
 
Extra: Step 5. Connecting to a GIS Server in ArcGIS Pro 

Other than using data from your local machine or network, it is possible to 
stream data from a server. Here, we will show you how to connect to a GIS 
server. Specifically, we will connect to the WV GIS Tech Center GIS Services.  

Note: This may not work depending on your administrative rights on the 
machine you are using. So, you may not be able to follow along with this 
demonstration.  

� In ArcGIS Pro, navigate to the Insert Tab.  
� Within the Project area, click on the dropdown arrow associated with 

Connections.  
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� Select New GIS Server. 
 

 
 

� As the Server URL provide the following address: 
services.wvgis.wvu.edu/ArcGIS/services. This website does not require 
a User Name or Password as it is open to the public.  

� Once the connection has been established, you can connect to data 
layer. You will first need to add a new map to the project in which to 
read in the data.  

� To add Data, click on the Add Data button in the Map Tab. Selection 
Servers under projects then select this server from the list. This will 
load the list of available layers. This can be slow, depending on your 
internet connection and speed. 
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� As an example, we navigated to the Boundaries folder and selected the 
wv_protected_lands_wm service. This added a layer of protected 
lands to the map.  

The WV GIS Tech Center GIS Services also provides imagery that you can 
stream. This can be a reference source for digitizing. Feel free to experiment 
with the available services.  

 

END OF EXERCISE 


